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Introduction 
 
This manual describes the Venable ESTiView Software that is part of Venable’s ESTi 
(Energy Storage Test instrument) and Nexus battery testing systems. 
 
This manual is provided in printed form with the hardware test device, in electronic form 
in the software and in electronic form on the download site.  The latest version of this 
manual can always be found on Venable’s download site beside the current software 
installation package.  The version in the current software installation can be reached 
using the menu item Help  Venable Manual. 
 
The Setup portion of this manual covers both the hardware and software setup.   
 
The Software works with a number of different hardware models of Venable ESTi and 
Nexus multichannel systems.  The Software adapts to the differences between models 
by showing different Control dialogs and making minor changes in other dialogs. 
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System Overview 
 

The Venable ESTiView Software, in combination with a supported Venable ESTi or 
Nexus, is a complete measurement and analysis system. 
 
The hardware portion consists of one or more Venable ESTi/Nexus, which is used for 
performing various operations on a battery, including charge/discharge operations, 
collecting data and performing AC impedance measurements. 
 
The Venable ESTi/Nexus is controlled by this software using a standard Ethernet 
connection. 
 
The ESTiView software runs on any personal computer using Microsoft Windows 7, 8, 
10 or 11, 32-bit or 64-bit.  
 
 
The Venable ESTiView software is protected against illegal copying and use. In order to 
connect or operate an instrument, or view data files, a matching license for the 
instrument must be activated. This is done through the menu item: Help -> License…. 
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Setting up the System 
 
Software Installation:  
 
1.   Close all your programs and insert the Venable installation disk into your CD-ROM 

drives. The CD should auto-run and the installation window should open up, 
otherwise browse the CD with Windows Explorer and double-click on 
VenableSetup.exe. Follow the prompts to allow the installer to install the Venable 
Software to your PC.  

 
2. Make sure you have your software serial number at hand and follow the instructions. 

 
The Venable software is protected against illegal copying and use. In order to 
connect to instruments and modify data files, each type of device must be activated 
by the Licensing Wizard built in to the Venable software.  From the software main 
menu, the wizard is accessible from Help -> License…. 
 
Manuals for the Venable software, “Venable Software Manual.pdf”, and the 
Licensing Software, “LicenseManual.pdf”, are included in the installation folder.  
These manuals are in Adobe portable document format (pdf) and are compatible 
with Adobe Acrobat Reader.   From the Venable software program you can open the 
manuals using the menu items “Help -> Venable Manual” and “Help -> License 
Manual”. 
 
If you need to uninstall the software for any reason, use Add/Remove Programs and 
choose the uninstall option. 

 
3. Set PC Sleep mode to “Never” in Power & Sleep settings.  
 
4. If you will be running a test for more than a couple of days, you need to disable 

the Windows Update service to insure that automatic updates do not interfere with 
your test, since Windows can be quite forceful in rebooting your PC. Do windows 
updates manually in between tests to insure Windows security is kept up to date. 

 Also, go to Windows 10 Settings>Accounts>Sign-in Options and there should be an 
option that says "Require Sign-In". Click the drop box below it and select “Never” to 
insure that Windows does not log you off and interfere with your testing. 

 
 
Hardware Setup: 

ESTi Unpacking and Setup: 

Remove instrument from shipping box and place on location to be used. It is 
recommended to save the shipping box for future recalibration shipments. 
 
Connect AC power cable to instrument and plug into AC outlet 
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Nexus Unpacking and Setup: 

Remove cardcage from shipping box and place on location to be used. 
Remove each channel from shipping box and slide into slot in cardcage according to 
slot labeled for each channel. Channel slot assignments can be changed later, as 
needed. 
If you purchased a unit with less than 10 
functional channel boards, the following 
steps are required: 
 1. Slots 0, 1 and 2 must be populated 
with functional channels. These slots 
manage the 3 cooling fans on the 
Nexus. 
 2. You will need to insert the cover plate 
that has the “dummy board” extender 
into the very next slot after the last 
populated channel board slot. The 
remaining cover plates are installed on 
the remaining open slots after the 
“dummy board” extender plate. This is 
necessary to insure proper airflow and 
cooling of the Nexus system. 
 
NOTE: New units have tight channel 
grounding springs and may require 
significant force to slide board into slot. 
It is best to push primarily on channel 
faceplate below main socket to apply 
force. 
Rotate fasteners clockwise to tighten 
channels into cardcage slots. It is 
recommended to save channel shipping 
boxes for future recalibration shipments. 
 
For multiple Nexus setups, alphabetic 
stickers are provided to identify each 
Nexus chassis. These stickers are applied just to the left of the power button on the 
front of the Nexus. 
Connect AC power cable to instrument and plug into AC outlet. 

 
Communication of the Venable software to the instruments is achieved using a standard 
Ethernet connection setup. Venable strongly recommends that connection of PC to the 
instruments be done using a dedicated Ethernet bus separate from the Ethernet 
connection used to network the PC to an office environment, otherwise unreliable 
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control and operation of the instruments could occur. This can be done by adding a 
second Ethernet interface to your PC. 
 
Disclaimer: Direct operation of an ESTi or Nexus, via the global internet from a PC at a 
remote location outside of the facility containing your ESTi or Nexus, is not currently 
supported due to potential for data packet corruption. This method of operation is at 
your own risk. 

Attaching PC to a single ESTi: 

In most cases, an Ethernet cable can be attached directly from the PC to the 
instrument. There is a possibility that the PC Ethernet hardware may not support 
automatic crosslinking, in which case, you will need to use a crosslinking (null 
modem) cable instead.  

Attaching PC to multiple ESTi: 

A standard multiport Ethernet switch will need to be obtained. Attach the Ethernet 
cable from the PC to one of the ports. Attach the instruments to the remaining ports 
on the switch. 

Attaching PC to a single Nexus: 

An Ethernet cable can be attached directly from the PC to the back of the Nexus. 

Attaching PC to a multiple Nexus: 

A standard 1 GB multiport Ethernet switch is recommended. Attach the Ethernet 
cable from the PC to one of the ports. Attach each Nexus to the remaining ports on 
the switch. 
It is also possible to connect without a separate switch. An Ethernet cable can be 
attached directly from the PC to the back of the first Nexus. You can then daisy-
chain the secondary ethernet ports on the back of the Nexus across Nexus units. 

Ethernet IP Address Configuration: 

 
The ESTi comes initialized to the default IP address of 192.168.214.214. 
 
Each Nexus comes with boards initialized to default IP addresses of 192.168.214.214 
thru 192.168.214.223 and are initially assigned in the order of slot assignments. IP 
addresses and slot assignments can be changed later, as needed. 
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In order to establish the initial connection of the ESTiView software to the instrument, 
the Ethernet interface in the PC will need to be configured to the IP address of 
192.168.214.254, 
subnet mask 
255.255.255.0. In 
Windows, open up 
the “Control Panel” 
application and 
select the “Network 
and Internet” 
category. Select 
“Network and 
Sharing Center”, 
then select 
“Change adapter 
settings”. Double 
click on the 
Ethernet adapter 
that will be used for 
the connection to 
the instrument. This 
will open up the properties window for that Ethernet port. Make sure that “Internet 
Protocol 4 (TCP/IPv4)” is check marked and click on the “Properties” button. This will 
open the window to change the IP address properties of the PC. Configure this window 
as shown in the figure below. 
 
After an initial connection is established with the instrument, the ESTiView software can 
be used to reconfigure to a different instrument IP address and PC IP address. 
However, the instrument and the PC must be kept in the same subnet space. If using 
multiple PCs to operate groups of ESTi or Nexus instruments, each PC will require a 
unique IP address. 
 
1.  Turn on the ESTi or Nexus Instruments. Wait for the instrument to complete startup; 

the green “Status OK” LED on front of instrument will illuminate when startup has 
completed. 

 
2.  Open the Venable software. Select the Actions menu in the Venable Software and 

click on the “Connect” menu item. This will display the connection dialog. Enter the 
IP address of the instrument you want to connect to (for ESTi first time use, this will 
be the default value of 192.168.214.214) and click on the connect button. Instrument 
Port value should remain unchanged with the default value. When the software has 
successfully connected to the instrument, the Status display box will show a valid 
connection. 
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Connect Button 
 
 

 
 
This button in the lower left section of the application window can be used to 
establish a connection with a particular instrument. 
 
Clicking on this button will bring up a connection dialog box. Each instrument that is 
connected onto the Ethernet network must have a unique IP address assigned to it. 
See section for the Utilities Tab for details on setting an instrument to a new IP 
address.  
 
Change the IP address to the address you would like to make a connection to. Then 
set the Channel number field to value that you would like to assign for this 
instrument. Each connection must have a 
unique value. Valid values are 0-15. Instrument 
Port value should remain set to the default 
value. 
 
For multiple Nexus setups, a chassis letter, as 
designated by the stickers applied to each 
Nexus chassis outlined in the Nexus hardware 
setup section, can be specified for each Nexus 
to manage multiple chassis. 
 
If you have more than 16 single channel ESTi 
units, the chassis selection can also be utilized to increase access to additional 
channels. 
 
Click on “Connect” to connect the instrument to the software. If the connection is 
successful, it will appear in the connection list. 
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Connection List 
 

 
This window shows active connections that have 
been made to devices under test. By default, it 
resides on the left side of the application window, but 
is moveable and can be undocked and moved using 
the bar at the top. For each device, the window 
shows 4 pieces of information. The status is shown, 
indicating whether a test is running or stopped. The 
active voltage and current levels are shown. Also the 
user assigned channel number and chassis letter is 
displayed in green on the left side of the battery 
symbol. 
The battery icon has three border colors to indicate 
the battery status; orange color to show that no test is 
running on selected battery, green color, to show that 
the test is running, and red color to show that the 
battery is stopped with error. 
 
The label "SOC Unknown" appearing on the battery 
icon indicates that the battery's charge level (State of 
Charge, SOC) cannot be identified for the current 

test. Once the SOC is successfully calculated, this label will disappear, and the battery 
icon will show varying levels of charge. 
 
The "Sort Ascending" and "Sort Descending" buttons 
allow you to arrange the channels in ascending or 
descending order, respectively. 
 
Left clicking on a particular device will show the 
design currently associated with it in the Design tab. 
It will also set the focus of operations for the Sensors 
and Utilities tabs and the Capture Waveform dialog. 
Right click on a device will bring up a sub-menu with 
2 options. 
 
The Disconnect option will disconnect the device from 
the application and remove it from the list. 
 
The Info option will bring up a dialog box that displays 
information about the selected instrument. There are 
two sections in the window: The top section shows 
information about the instrument. This information will 
include the serial number of the instrument, Ethernet 
IP address settings and firmware version information. 
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The bottom section will display status information of the instrument and some error 
information regarding the user defined test scenarios. 
 
Some errors in a defined test scenario such, as a general error in a variable/formula 
definition, or an attempt to divide by zero in a variable/formula definition, will be 
recorded by the instrument and displayed in the status information window.  
 
Also, any failure in power with the instrument, or with the main power amplifier driving 
the output of the instrument, will be recorded by the instrument and displayed in the 
status information window. 
 

Support Function 
 
This window displays the functions and tests that are 
supported by the instrument. Functions/tests that are 
available for use are indicated with a green check 
mark, while those that are not supported will appear 
grayed out and are denoted by a red cross. 
 

Message Box 
 
This section shows error and warning messages from 
the instrument and the ESTiView software. 
 

 
 
 

Design Tab 
 

Node Editor 

 
This window is used to design new test scenarios. There are three main sections in 
this window, the icon selection bar along the top, the node layout and connection 
editor on the left and the node parameter editor on the right. 
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 The icon selection bar 

 

 
 
The icon selection bar is a drag and drop list of test types available to perform using 
the instrument. Use the mouse cursor to hover over any icon in order to display what 
type of control function that particular icon is. 
 
To drag and drop an item into the node layout and connection editor block, move the 
cursor over the icon and left click on the icon to select it. Then move the cursor into 
the node editor window to the position you want to place the icon. Left click again to 
place the icon into the editor. You do not need to hold the left mouse button down 
while dragging the icon into the editor. 

Shortcuts 

There are four shortcuts on the selection bar: The disk icon can be used to save 
your test definition. The folder icon can be used to Load a saved test definition. The 
copy can be used to copy the entire test into clipboard. The paste icon can be used 
to paste the recent copied test into the layout. 
 

The node layout and connection editor 

 
After placing icons into the editor window, you can move the icons around in the 
workspace by left clicking on the icon and holding the left mouse button down. To 
place the icon in the new location, release the left mouse button. 
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Each icon has one input connection (left side of icon) and 4 output connection (right 
side of icon) points for linking transition flow between icons. In 
order to link two icons, place your cursor to point to any output 
connection (the connection point will be highlighted with a white 
block, as shown), left click and hold while moving the cursor to 
any input connection. Release the left mouse button on the input 
connection chosen. A line should now exist between the two 
icons linking them together. 

 
The viewable space in the editor is larger than what is visible at any time. It provides 
the ability to zoom in or out in the viewable area, and to move the viewable area of 
the window to a different section of the test layout. In order to zoom in/out, move the 
cursor to any location within the editor and then use the scroll wheel on your mouse 
to zoom the viewable area in or out. To move the viewable area of the window to a 
different section of the test layout, move the cursor to any location within the editor, 
left click and hold the button while moving the mouse. Releasing the mouse button 
will set the focus of the viewable area to the new location. 
 
To edit the control parameters of any particular node, position the cursor over the 
icon in the layout and connection editor and double click the left mouse button to 
select that node and display the control parameters for that node in the node 
parameter editor on the right side. 
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 The node parameter editor 

 
The node parameter editor is used to 
configure various aspects of the control 
node selected. The node ID value that 
the software assigns to the selected node 
is shown at the top of this box. The node 
editor consists of several sections.  
 
The top section contains the elements to 
set channel measurement ranges and set 
the amplitude levels of the output. 
Current Range adjusts both input 
measurement and output generation 
ranges together. Voltage Range only 
affects input measurement range. Output 
Voltage Range is fixed to 18V. 
 
The next section consists of Stop Limits 
associated with the selected node. 
 
The next section consists of enabling 
event counters that were defined in the 
Formulas tab. Enabled counters can be 
set to increment on node entry or node 
exit. 
 

The next section consists of Log enable 
and selection parameters for data 
collection purposes for the selected 
control node.  
 
The next section contains additional measurements or capabilities that are specific 
to the control type being performed. Varieties of this section are explained in further 
detail below. 

ACZ Sweep (Requires supported model) 

(This section is associated with DC charge/discharge nodes.) 
An AC impedance sweep can be enabled during execution of the charge/discharge 
control by clicking on the checkmark box for ACZ Sweep. Start and Stop frequencies 
can be set to sweep either up or down in frequency. Amplitude of AC waveform and 
integration methods and times are also set up in this box. Care should be taken to 
insure that “ACZ Sweep Complete” is used as part of the exit condition criteria to 
insure that the control does not attempt to exit before a frequency sweep has 
completed. “The ACZ Sweep Complete” exit criteria is a TRUE (1) or FALSE (0) 
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operation and should be normally setup in your condition as “ACZ Sweep Complete 
> 0”. This function is available in both potentiostatic (voltage) controls and 
galvanostatic (current) controls. 
 

PITT / GITT 

Potentiostatic / Galvanostatic Intermittent Titration Technique 
(This section is associated with 
Voltage and Current 
charge/discharge nodes.) 
This is used to enable 
incremental steps in amplitude 
to support this testing technique. A 
charge/discharge and rest loop (see figure) must 
be defined in the node editor for proper operation 
of this technique. In potentiostatic mode, the rest 
voltage will automatically carry over as the output 
amplitude into the first entry of the 
charge/discharge operation. It may also be 
required to enable PID feedback control to 
maintain constant output level in potentiostatic 
mode. 

AC Voltammetry (Requires supported model) 

(This section is associated with Ramp nodes.) 
An AC voltammetry operation can be enabled during execution of a ramp node 
function. This function performs a single frequency impedance measurement at 
regular repeating intervals during the ramp function. The injection frequency and 
amplitude are specified by the user, as well as the integration method and time for 
the measurement. This function is available in both potentiostatic (voltage) controls 
and galvanostatic (current) controls. 

Pulse Editor 

(This section is associated with Pulse nodes.) 
This section is used to create a pulse waveform definition. Right click inside the 
definition block to bring up the “insert” button and then left click on the button to 
insert a step into the definition. Move the mouse cursor into the Time field and 
perform a single left click to select the field. Then enter the time value into the field 
and press enter to save the value in the field. Modifying the Amplitude field is done 
the same way as the Time field. A visual representation of the defined waveform is 
displayed below the definition box to provide a visual verification of the designed 
waveform. 
NOTE: The Time field may be automatically restricted or adjusted based on the 
setting of the Sampling frequency. The Amplitude field may be automatically 
restricted or adjusted based on the Range settings. 
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Node Types 

Begin:  Marks the starting point of any test scenario. The Start Test menu option will 
initiate testing from this point. The Begin must be connected to one node only. Test 
initiation will immediately transition into this next node when a start is initiated. A 
begin node is automatically added to the node layout editor whenever a new test is 
created. 
 
End:  Marks the completion point of any test scenario. A test can have multiple 
completion points. Adding several End nodes is allowed for test design. Also, 
multiple node outputs can be connected to a single End node. 
 
Rest:  This control is used to pause testing and disengage the output relay on the 
instrument in order to fully disconnect the battery from the instrument to prevent 
loading effects. Only the Voltage sense probes are still connected to device under 
test to monitor voltage levels. 
 
Current Charge:  Performs a DC current charge on the device under test at an 
amperage level specified by the user. AC impedance sweeps on supported models 
are also available with this function. 
 
Current Discharge:  Performs a DC current discharge on the device under test at an 
amperage level specified by the user. AC impedance sweeps on supported models 
are also available with this function. 
 
Voltage Positive:  Applies a constant positive DC voltage to the device under test. 
Charging or discharging depends on the active voltage level of the device. AC 
impedance sweeps on supported models are also available with this function. 
 
Voltage Negative:  Applies a constant negative DC voltage to the device under test. 
Charging or discharging depends on the active voltage level of the device. AC 
impedance sweeps on supported models are also available with this function. 
 
Current Ramp:  Performs a linear current change from a defined amperage level to a 
second defined amperage level. Time duration for the linear change is defined by 
the user. Current Ramp nodes can be added back-to-back to create other 
waveforms such as saw tooth and triangle waveforms. The maximum attainable 
frequency of such waveforms is around 1 kHz. The AC voltammetry function on 
supported models is also available in conjunction with the current ramp function. 
 
Voltage Ramp:  Performs a linear voltage change from a defined voltage level to a 
second defined voltage level. Time duration for the linear change is defined by the 
user. Voltage Ramp nodes can be added back-to-back to create other waveforms 
such as saw tooth and triangle waveforms. The maximum attainable frequency of 
such waveforms is around 1 kHz. The AC voltammetry function on supported 
models is also available in conjunction with the voltage ramp function. 
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Current Pulse:  Injects a user defined pulse train of up to 256 transitions of various 
amplitudes and time durations for each pulse. Output frequencies of up to 100 kHz 
are possible with this function. The pulse train will repeat until an exit condition is 
met. A “Single Only” option is available to inject only a single sequence of the pulse 
train and immediately exit to the next control node. 
 
Voltage Pulse:  See Current Pulse above. 
 
Power Charge:  Perform a charge on the device under test at a constant power level 
specified by the user. 
 
Power Discharge:  Perform a discharge on the device under test at a constant power 
level specified by the user. 
 
Load:  Sets the instrument to act as an electronic load at the resistance (ohms) level 
specified by the user. This function acts as a discharge function only. 
 
 
Conditions (editor) 
 
Double left mouse click on a connection link in order to select that link for editing. 
The link will be highlighted yellow and the focus of the editing window on the right 
will change to bring up the exit condition criteria for the selected link. The condition 
editor contains three main parts. The copy/paste buttons are at the top, the variable 
and criteria selection is in the middle, and the condition listing for the node exit 
criteria is at the bottom. This window will initially be blank after creating a new link 
between nodes. Right click in the window to bring up a button to add an exit 
condition and then left click on the button to add a new condition. Several exit 
conditions can be added for one link. 
 
Each condition listing must 
then have one or more 
expressions added to the 
condition to create one exit 
criteria. To add an 
expression, move the cursor 
over the desired condition 
and right click to bring up the 
button to add an expression. 
Left click on “Add 
Expression” and a new 
expression equation will be 
added below the condition. 
The criteria for the 
expression are modified by 
left clicking on the expression. 
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Use the criteria selection boxes above the listing box to change the expression 
values. In order to create an expression, a user will select a variable, either a default 
variable or a user defined variable for “Variable A”, to compare against either 
another variable or against a static value in “Variable B”. Variable B has a toggle 
button to transition between variable selection and static value editing. 
 
When adding 2 or more expressions to a condition, the expressions must be related 
together using the Boolean operator. In a situation of 2 expressions, this determines 
whether only one or the other needs to be true (Or) for the exit to occur, or whether 
both need to be true (And) for the exit to occur. The “And” operator can also be used 
to separate multiple groups of “Or” criteria. This allows the user to create complex 
exit conditions for a particular node. 

 
When more than one condition is added to a condition link, the control node will exit 
based on either condition being true. Each condition and expression that is added 
will incur an increase to the instrument processing utilization. When doing pulse or 
ramp functions at higher sampling rates, less processing time may be available and 
large condition definitions may not be possible. 
 
The condition editor has a “Counter to Reset” drop box which contains a list of all the 
available event counters. This drop box allows the user to select an event counter to 
be reset when either condition is true.  

 
The copy/paste buttons allow users to copy the exit condition criteria for the selected 
link and paste it into another exit condition criteria link for the same test. This feature 
will save time when there are many links that have the same exit condition, 
especially when the exit condition criteria are complicated. 

 
Formulas (Variable creation / editor) 
 
The primary of formulas is to create user defined variables for use in condition 
operations or for use in formulas to create other user defined variables. Complex 
equations can be created using multiple variables together. When creating complex 
equations using multiple 
variables, the order of variables 
and use in formulas is important 
to insure that all intermediate 
calculations are performed on the 
same processing cycle as the 
final variable calculation. 
 
The formula editor contains two 
main parts. The variable and 
criteria selection is at the top and 
the formula listing is in the box 
below it. To add a new variable 
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with an associated formula, right click in the listing box. A menu of 3 choices to 
create, Direct Computation, Conditional Assignment or Event Counter, will appear. 
Left click on the choice to create it. Each of the two choices is explained in more 
detail below. Move the mouse over the new variable method created and left click on 
it to select the newly created variable with its associated method. In the editing 
boxes above, you need to select whether this new variable is to be defined as an 
integer or as a floating point value. Integer values are more efficient for processing 
utilization and should be preferred over floating point values whenever possible. In 
the Name box below it, you can specify your own name to identify the variable by 
simply selecting the default text and replacing it with new text. 
  
Move the mouse over the new variable method created and right click on it to bring 
up the menu to add a new expression to the method, then left click on it to add it to 
the list. Left click on the expression to select it and bring up the expression editor 
above the listing box. Select a variable from Variable box A, and then select an 
operation to perform with the variable on either another variable from Variable B or 
an editable value. The toggle button to the right of Variable B will switch between 
variable selection and editable values. You can add up to 8 expressions for each 
Direct Computation or Conditional Assignment. Each formula and variable that is 
added will incur an increase to the instrument processing utilization. When doing 
pulse or ramp functions at higher sampling rates, less processing time may be 
available and larger definitions may not be possible. 
 
There are two distinct methods to create a new user defined variable; Direct 
Computation and Conditional assignment. 

Direct Computation: 

This performs an arithmetic operation on a combination of variables and/or static 
values. The operations that can be performed are plus, minus, multiply and divide. If 
the variable is being defined as an integer, the list of operations will include the 
binary operations of “AND” and “OR”. 
When adding 2 or more expressions, the subsequent operations will be performed 
between the result of the preceding expression and the Variable B selection of the 
new expression. See appendix A for examples of Direct Computations. 

Conditional Assignment: 

This performs a “compare and set” operation by comparing a chosen variable in 
Variable A, against a combination of other variables or static values. The new 
variable will be set to the value of the variable in the first instance of Variable A when 
the entire expression set has evaluated to TRUE. The new variable created must be 
of the same type, integer or float, as the variable selected in the first instance of 
Variable A, otherwise a computation error will occur. The operations that can be 
performed are ‘less than’, ‘less than or equal to’, ‘greater than’, ‘greater than or equal 
to’. Multiple expressions in a conditional assignment are always ANDed together for 
compound expression evaluation. See appendix A for examples of Conditional 
Assignments. 
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Event Counter: 

This creates event driven counters that can be used to keep track of the number of 
cycles that have occurred in a loop.  There are no expression definitions for event 
counters. Counters can be configured in the Node Editor. 
 
Logs 

Logs are the primary method 
of data collection provided by 
the instrument and software. 
The logs allow the user to 
select one or more variables, 
default or user-defined, to 
capture and store into a file 
for future analysis. The logs 
tab is split up into three 
sections. The list of user 
defined logs is created and 
displayed in the top left box. 
The list of variables to select 
from is displayed in the top 
right box. At the bottom of the 
window is the condition editor 
used to define conditions 
when a log of data should be 
recorded. 
 
To create a new log, move 
the cursor into the top left box 
and right click to display the 
menu. Left click on “Add Log” 
to create a new log definition 
in the list. Left click once on 
the log to display the variable 
selection list for that particular 
log in the list on the right side. 
Variables to log are selected 
by setting a check mark next 
to the variable. Log names 
can be changed with your 
own names by double left 
clicking on the log definition 
on left side. This will highlight 
the text and allow you to 
change it with your own text. 
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Unselect the log definition to save the new name. 
A logging of data can be set up to occur in one of three ways. 1) On entry into a 
control node, 2) On exit out of a control node, or 3) Based on a condition event 
occurring. Log definitions are available to all control nodes and are enabled for each 
control node independently. Once a log definition has been created, the log can be 
enabled in the node editor for a particular control node. Each node allows activation 
of up to 4 log definitions. In order to enable a log, select the control node of interest 
in the node editor by double clicking on it to bring up the node editor screen on the 
right side. Selecting a log from the pulldown list of logs in the Log Enable section, 
will activate the log for that control node and will generate a data log based on the 
log conditions that were set up for that log. A log can also be generated on “entry 
into” or “exit from” a control node by check marking the check box next to the log 
selection and then selecting the choice of entry or exit in the pulldown menu next to 
the check box. Entry/Exit settings can be used in conjunction with condition-based 
logs in a particular node. 
 
To delete a Log definition, move your cursor over the definition to delete and right 
click on it. A menu will appear. Left click on “Delete Log” to remove the log definition.  
 
Transmit Log (Manual Request):  When you right click on a log definition, the menu 
will also show an option to transmit a Log on request. This can be used to test your 
log definition. Received log data will be stored to a file on the PC. In order to use this 
function, you must have created a log definition, connected to an active instrument 
and have loaded your test definition into the instrument. 
 

Conditions (editor): 

Each log definition can have its own set of logging conditions set up for it. To create 
a condition, select the log in the top left list. Move the cursor down to the condition 
listing at the bottom. Right click in the window to bring up a button to add a condition 
and then left click on the button to add a new condition. The method of adding and 
defining expressions to the conditions and adding additional conditions is identical to 
how it is done for node conditions. Reference the conditions (editor) section for 
details and restrictions in defining conditions for data logging. 
 

Logs at timed intervals: 

It is often necessary to collect data at regular timed intervals. See Appendix A for an 
example of how to set up your formulas and log conditions in order to accomplish 
this function. 
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To create a timer interval 
to log data, click the 
“Create Log Timer” 
button. A small dialog will 
appear which allows the 
user to enter the time 
interval in seconds. Enter 
the time and click “OK”. 
The software will create 
two user-defined variables 
(direct computation and 
conditional assignment) in 
the formula tab and one 
log condition in the log tab.  
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Config 

The config tab allows you to configure the instrument itself at an overall test level. 
These settings apply to the entire test, not for any particular control node. 
 
Monitoring Interval: The instrument can transmit the entire variable data set at 

regular intervals for general purpose monitoring in the Monitor tab window. The 
interval setting has a resolution of 0.1 seconds. The interval can also be set to 0 
to turn off generation and transmission of this data completely. Lower interval 
settings, other than 0, will incur a performance hit on Ethernet bandwidth 
availability and on instrument processing utilization. 

 
Shutoff Voltage/Current: The purposes of these settings are to prevent over-voltage 

or over-currents from occurring that can damage a device under test. These 
settings can be used to configure the instrument to stop all testing if defined limits 
are exceeded. 

 
Aux Port Range: When using the auxiliary port as a secondary voltage sensor, this 

setting will set the port to the applicable range setting. Lower range settings will 
provide higher accuracy of measurement. The auxiliary port is configured as an 
analog voltage sensor only when no sensors have been enabled in the 
“Sensors” configuration tab. 

 
3 or 4 Terminal Mode: This setting allows you to configure the instrument into a 

remote voltage sensing configuration for the RE+, RE- sense lines for use in 3 
and 4 terminal applications. 
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Monitor Tab 
The Monitor Tab is used to examine general operation and statuses of the selected 
instrument. A monitor window is added to this display by selecting a device in the device 
list and clicking on the “Add Monitor” button at the bottom of the list. One or more 
devices can be monitored simultaneously through this display window. The window has 
3 main parts, status information is on the left, a running display of active levels is shown 
on the right and sensor information is in the center. 
 

 
 
The status information box includes items such as which control the instrument is 
currently operating in, how long the test has been running, how long the active control 
has been running, and what the voltage, current and charge levels are. There is also a  
Processing Utilization Meter: The design of our instrument and software allows for a 
very wide range of configuration possibilities. As a result, it is not possible to determine 
at the PC software level whether your test may exceed the processing limitations of the 
instrument. The processing utilization meter is provided here to assist you in 
determining if your test design is reaching or exceeding the processing limits of the 
instrument and needs to be scaled back. 
 
The Sensors box contains information on internal temperature levels inside the 
instrument, present levels of any temperature sensors that have are attached to the 
instrument and activated, and present levels of pressure sensors that are attached to 
the instrument and activated. 
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The Active Measurements window shows a running display of the Voltage and Current 
levels for the battery that is attached to the instrument. The plots show a record of up to 
1000 data points. Older data points will automatically be purged from the plot. The 

Monitoring interval in the Design->Config Tab adjusts the update rate for the monitor 

window for each instrument. 
 
The status information box and sensors 
box can be hidden/shown by unchecking 
/checking the “Show status and sensors 
info” box under the active measurements 
window.  
 
The graph axis time supports two format: 
“seconds” and “days,hours:minutes:second”. The default format is in “seconds”. To 
switch to the “days,hours:minutes:second” format,  check  “days-hh:mm:ss”.  
 
The graph axis can be adjusted using the mouse buttons and scroll wheel. See section 
on Mouse Shortcuts for details. Right click on a graph to bring up a menu of selections 
to change characteristics of the plot or to save the current plot displayed 
out to files of various formats, graphical or text. A graph that has been 
manually adjusted, can be reset to the default auto-scaling, auto-update 
mode by clicking on the “A” in the lower left hand corner of the graph.  
 
 

Graphs 
 
Impedance, Nyquist (On supported models) 

These graphs are associated with AC impedance testing. They are used to display 
testing data for AC impedance sweeps performed during constant charge or discharge 
control nodes and AC voltammetry tests during Ramp based control nodes. 
 
When an instrument is actively performing one of the AC test noted above and the 
instrument is actively selected in the instrument selection list, the results of the test will 
be plotted in real time to both Impedance and Nyquist graphs. The data from these tests 
will also be saved into Venable data files with the extension of “.vacz” regardless of 
which device is selected for monitoring. The default names assigned to the files during 
AC test contains the following: Chassis Number, Channel Number, Date and Time 
(Chas#_Chan#_Year_Month_Day_Hour_Minutes_Seconds). These files can be 
recalled into the graphs using the “Open ACZ file” button on the left bottom portion of 
the window.  All displayed plots are listed in the listing box on the left side of the graph 
window and can be selected by clicking on the plot name in the list. You can also hide a 
particular plot by unchecking the check box for the desired plot. 
 
The name of each plot can be modified by the user. In order to change the default 
name, double click on the file name in the listing box to highlight the text for 
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modification. Then enter a new name. This will also change the name of the file that the 
data set is stored to within the saved folder. It is recommended that you leave the file 
extension “.vacz” intact in your new name in order to identify this data as AC impedance 
data. Each plot label can be moved using the mouse to drag the label to a new position. 
 

Export to ZView  : This button will export the selected data into a file compatible with 
the ZView software developed by Scribner Associates, Inc. 
 
Tafel 

This graph is associated with cyclic voltammetry testing. In order to use this graph, you 
will need to define a log that will capture voltage and current information at regular 
intervals. The data defined by the log will be stored into a file on the computer. The 
result data file can be loaded into the graph using the “Open Tafel Log file” button. 
 
The default names assigned to the files during AC test contains the following: Chassis 
Number, Channel Number, Node ID, Date and Time 
(Chas#_Chan#_NodeId_Year_Month_Day_Hour_Minutes_Seconds).  
 
The name of each plot can be modified by the user. In order to change the default 
name, double click on the file name in the listing box to highlight the text for 
modification. Then enter a new name. This will also change the name of the file that the 
data set is stored to within the saved folder. It is recommended that you leave the file 
extension “.vlog” intact in your new name in order to identify this data as logging data. 
 
Add Slide Bar 

This function is accessed through the “Add Slidebar” icon located on the top left 
of the graph. The slide bar is useful for tracking and displaying data values at a 
specific frequency, represented by a vertical line and a description box. The Add 

Slide Bar command can only be run when a single data set is selected. More than one 
slide bar may be opened at one time, either from the same or different data sets. 
 
The bar can be dragged using the mouse pointer, and the box will contain the data at 
the selected frequency. The box can be dragged up or down along the slide bar using 
the mouse. To delete a slide bar, right click on the bar. This will show a delete button. 
Click on delete button to remove the slide bar. 
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Method for Calibrating Impedance 
Method for Extending Impedance Accuracy 

The EstiView software includes a Math package to allow for correction of parasitics in 
EIS measurements introduced by the instrument itself and the attaching cables. It is 
also possible to achieve accuracy extension beyond the base Accuracy Contour Plot of 
approximately 2 decades. Access to these math tools can be done through either the 
Menu, Tools->Math, or through the Open Math Tool button at the bottom of the file list. 
The following procedure outlines the steps necessary to perform this correction on your 
measured impedance plots. This procedure will utilize two 100 microOhm current sense 
resistors to obtain open and closed loop plots for use in the math calculations. Venable 
recommends Vishay part: WSBS5216L1000JK for the best conductive quality material 
and insure the highest quality results. 
 
Measure Closed Loop Impedance: 
Connect all test leads across one side of the sense 
resistor as shown. Create a galvanostatic ACZ 
impedance sweep test with the current range set to 5 
Amps and the Voltage range set to 1.8 V. The AC 
amplitude will need to be set to 3 Amps. Set desired 
Start and Stop frequencies. Run the test to plot and 
record the Closed Loop impedance. 
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Measure Open Loop Impedance: 
Connect the Counter electrode and 
RE+ test leads across one side of one 
sense resistor. Then connect the 
Working Electrode and RE- across one 
side of the second sense resistor. This 
is demonstrated in the figures shown. 
NOTE: Do not allow the 2 sense 
resistors to come into contact with each 
other.  
Create a potentiostatic ACZ impedance 
sweep test with the Voltage range set to 18V. 
Setting the current range will depend on the frequency range you are sweeping to 
insure that proper range is set to account  active current amplitudes. For frequencies 
below 1 kHz, set the range to 5 microAmps. For frequencies above 1 kHz, set the range 
to 5 milliAmps. The AC amplitude will need to be set to 10 Volts. Set desired Start and 
Stop frequencies. Run the test to plot and record the Open Loop impedance. 
 
Measure Device Impedance: 
Generate an ACZ impedance sweep test appropriate to the device under test and 
perform the sweep to obtain the uncorrected measurement plot of the device. 
Choice of correction will now depend on where your device plot exists relative to the 
Open and Closed Loop plots. A low impedance device plot is too far below the open 
circuit impedance to require compensation for open circuit parasitics. Similarly, a high 
impedance plot is too far above the closed circuit impedance to require compensation 
for closed circuit parasitics. 
 
Low Device Impedance: 
For this case, we correct for short circuit parasitics by subtracting the short circuit 
impedance from the test data. Open the Math Tool. For the Left Operand, select the 
bullet Data Set and select the Device data set. For the Right Operand, select bullet Data 
Set and select the closed loop plot data set. Set Actions selection to Subtract and click 
on the Plot button. The resulting graph will be the device impedance corrected for 
parasitics.  
. 
High Device Impedance: 
The same concept as Low Device Impedance can be used for measuring high 
impedances and correcting for open circuit parasitics, except it is a little trickier because 
the open circuit parasitics are in parallel with the test data instead of in series. 
Essentially, what you want to do is subtract the admittance of the open circuit parasitics 
from the admittance of the test data (which includes the impedance of the device under 
test in parallel with the parasitic open circuit impedance).  We have a feature in the 
Math Options called Subtract in Parallel.  This will put the negative of the parasitic 
impedance in parallel with the test data, effectively canceling out the open circuit 
parasitic impedance and yielding only the impedance of the device under test. 
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Open the Math Tool. For the Left Operand, select the bullet Data Set and select the 
Device data set. For the Right Operand, select bullet Data Set and select the open loop 
plot data set. Set Actions selection to Subtract in Parallel and click on the Plot button.  
The resulting graph will be the device impedance corrected for parasitics.
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Sensors Tab 
 
This window provides 
the ability to activate 
various optional 
sensors that have 
been attached to the 
instrument and 
provide a user 
calibration of the 
sensors. Click on the 
check box on the left 
side to activate a 
particular sensor. A 
linear calibration of the sensor is provided in this window as well. For thermal sensors, 
you will need to determine the error of the sensor against a known accurate standard at 
two temperature levels: 0 degrees Celsius and 60 degrees Celsius. The amount of error 
relative to the standard, positive or negative, is entered into the two respective fields 
associated with the sensor. This will provide you a good calibration of the sensor in a 
range of -40 degrees Celsius to 100 degrees Celsius. Once sensors have been 
selected and calibration information has been entered, you can transmit this information 
to the instrument by clicking on the “Send” button. Once this is done, the instrument will 
be configured with this sensor setup until the next power cycle is performed on the 
instrument. 
NOTE: Calibration for higher temperatures is possible using interpolation methods of 
the 60 degree offset against a measurement of a standard at the higher temperatures. 
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Utilities Tab 
 
This window contains various instrument configuration utilities that are generally 
unrelated to the design and testing operations of the instrument. 
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Set Instrument Network Settings: 
This can be used to change the Ethernet IP address of the instrument. New ESTi 
instruments are delivered with a default IP address 192.168.214.214. If you have 
multiple instruments, this utility can be used to set each instrument to a unique IP 
address. After entering your updated information in the box, click on the “Send” button 
to update your instrument with the new IP address information. The new settings will 
take effect after cycling the power on the instrument. 
 
Note: You must be able to connect to the instrument prior to any attempt to change and 
send the new IP address information. 
 
There is also a check box that will configure the instrument back to the default values 
above. If this box is checked, the information in the address box above it will be ignored. 
 
Force to Next Node: 
This provides you the ability to force operation of the selected instrument to the next 
node in your test setup. Enter the Exit path number (1-4) into the box, corresponding to 
the path you wish to take out of the active node. Then push “Send”. The selected 
instrument will immediately transition to the new node for operation. 
 
Impedance and data-logs settings: 
This allow you to choose the folder path to the location on the PC where your data 
logging files and Impedance data output files are stored to. 
 
SMS Notifications: 
This section allows you to set up texting notifications based on events occurring in the 
test instrument. Supported providers are listed in the SMS Company pulldown. You will 
need to set up an account with a supported provider in order to enable this feature. 
Once an account is setup, you will need to select the provider and then enter your 
username, password and subscription-provided phone number into the fields. Enter the 
receiving phone number in the “To Number” field for text messages to be sent to. The 
texting setup can be verified by entering a test message and then clicking on the “Test” 
button. You should receive the test message on your cell phone or other texting device.  
 
A selection box is provided to choose the events that will trigger a text message to be 
sent to you. The message will include identification of the instrument for which the event 
originated from. 
 
Heartbeat Settings: 
This section allows you to configure the heartbeat interval and the number of 
consecutive beats/attempts. The heartbeat is a common technique for monitoring the 
connection between the instrument and the computer and detecting connection breaks. 
The default heartbeat interval for new ESTi instruments is 5 seconds, and the number of 
consecutive attempts is 4.  By clicking on the "Heartbeat Current Settings," the software 
will display the current heartbeat settings in the boxes.   
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Shortcut icons 
 
There are short icons for Start Test and Stop test on the bottom left of 
the software window. To use these shortcuts, you must have an active 
connection to an instrument, have selected the instrument from the 
selection list and have already loaded a valid test scenario into the 
selected instrument. Click on the Start Test icon to initiate the test. The 
Stop Test icon can be used to abort and end the testing operation completely for the 
selected instrument. 
 
NOTE: Do not “Start” a test unless a valid test scenario has been loaded into the 
instrument. Otherwise damage to the instrument or device under test could occur. 
 
 

Main Menu 
 

 
 

File 

New Test 

This selection will erase any test created in the node layout and connection editor. It 
will also delete any formulas that have been created and any Logs that have been 
defined. It will also reset parameters in the Config tab back to their default values. 

Open Test 

This selection will open a file selection dialog box. Navigate to the file containing a 
saved test configuration. Double click on the file to select it and load the test into the 
node layout and connection editor. Formulas, Logs and Config information are also 
saved in the file and will be restored in their respective tabs. 

Save Test 

This selection will store the test configuration created with the node layout and 
connection editor, the conditional assignments associated with condition links, all 
Formula definitions and all Logs defined. This selection will also save parameters 
defined in the Config tab. 

Print 

Prints the active graph, including titles, curves and slide bars to the selected local or 
network printer. 

Print Preview 

Displays what the printed page will look like. This is recommended before you print. 
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Actions 

Predefined Tests 

This will display the predefined tests window. This window allows you to build the 
most common electrochemistry tests easily and quickly.  
 
The panel on the left shows the available tests, while the panel on the right shows 
the test parameters settings, the test description, and the applied waveform to the 
cell.  
Once you select the test and configure its parameters, click on the build button. The 
software will build the selected test. 
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Connect 

This will display the connection dialog. Enter the IP address of the instrument you 
want to connect to and click on the connect button. (Instrument Port value should 
remain set to the default value). When the software has successfully connected to 
the instrument, the Status display box will show a valid connection. 

Load Test 

This will download a defined test scenario into the selected instrument. The 
download will include all node and condition definitions, all defined formulas and all 
defined logs, including their respective condition tests. It will also download the 
parameter data from the Config tab. Sensor activations and settings are not included 
in this function and must be performed separately. New tests can be loaded while 
the instrument is running a test. However, the transition to the new test will not occur 
until the active node exits. Care must be taken that the new test contains a node 
number corresponding to exit node of the active node in the old test. 
The software provides a function to validate the test. When you click "load Test", the 
function will check all the nodes connections and exit conditions. If the test is valid 
the test will be loaded to the instrument, If not the software will show either an error 
message or waring message. If the software shows an error message, the test will 
not be loaded to the instrument. 

Start Test 

This will initiate testing activity for the selected instrument. The software must have 
an active connection established to the selected instrument and have a valid test 
scenario downloaded into the instrument. 
 
NOTE: Do not “Start” a test unless a valid test scenario has been loaded into the 
instrument. Otherwise damage to the instrument or device under test could occur. 

Stop Test 

This can be used to abort and end the testing operation completely for the selected 
instrument. 
 

Capture Waveform 

This item essentially provides an oscilloscope capability for the instrument and 
software. Selecting this menu item will open a separate window containing two 
graphing windows to show plots of voltage and current levels. On the left side of the 
plots are controls to configure the instrument for a data capture. This function 
captures detailed data at the sampling rate set in the instrument. For constant 
charge/discharge operations, the sampling rate is selectable up to 50 kHz. Ramp 
and Pulse functions can be set to higher sampling rates of up to 208 kHz.  
 
The capture will be performed on the selected (highlighted) device in the connection 
list. 
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To perform a data capture and display, select the total number of samples you wish 
to capture, a decimation rate that defines the rate at which to skip samples and then 
number of samples to collect prior to the trigger point. Then select whether to trigger 
on a voltage or a current level, the trigger direction, positive or negative, and the 
amplitude of the trigger point. 
 

 
 
Click on the “Send” button to engage the request with the chosen trigger point. 
When the instrument reaches the trigger point, the data will be sent back to the 
software and immediately displayed in the plot windows. Once the trigger has 
occurred and the plots are displayed, the trigger can be immediately set again by 
clicking on the “Send” button again.  

 
The graph axis can be adjusted using the mouse buttons and scroll wheel. See 
section on Mouse Shortcuts for details. Right click on a graph to bring up a menu of 
selections to change characteristics of the plot or to save the current plot displayed 
out to files of various formats, graphical or text. A graph that has 
been manually adjusted, can be reset to the default auto-scaling, 
auto-update mode by clicking on the “A” in the lower left hand 
corner of the graph.  
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Tools 

Math  

This will open the Math tool window. This tool is used for correction of parasitics in 
EIS measurements introduced by the instrument itself and the attaching cables.  

Update firmware… 

This will open the Venable ESTi Application Firmware Update tool. This is an 
executable file and is used to update the ESTi instrument firmware. 

 
Help 

Venable Help 

This will open an interactive help window detailing operation of the software. 

Venable Manual 

Opens the Venable System software manual, which is located in the program 
directory with the Venable System program executable. This file is in Adobe portable 
document format (pdf) and is compatible with Adobe Acrobat Reader. An installation 
program for Adobe Acrobat Reader can be downloaded at www.adobe.com. 

License… 

This will open the software licensing tool in a separate window. The licensing tool 
shows the currently active license being used and provides a button, "Change 
License", to restart the Venable License Wizard (Administration rights required).  A 
separate manual, titled “Venable Software License Manual” is provided and details 
use of the licensing software. 

About Venable… 

This opens a separate window, with the Venable Industries logo, that includes the 
software version number, internet address and general copyright information. 

 

http://www.adobe.com/
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Nexus Synchronization 
 
Serial Connection of channels (Stack Up) 
The following diagram show method to connect channels in a serial configuration to 
boost voltage. It is not recommended to exceed the maximum number of channels listed 
in each testing method to insure the stability of the stack before and during testing. 
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EIS  Testing 

Nexus channel can be connected in a serial configuration with a maximum of 8 
channels to boost voltage capacity. This provides a maximum battery limit of 140VDC. 
Operational stability of the stack improves with fewer channels, so it is recommended to 
use only as many channels in a serial configuration as needed to meet your voltage 
requirement. 
 
When connecting to channels with the EstiView software, all channels in the stack must 
have chassis letter selected and the synchronization enabled (Synced: checkmarked)  
 
The following constraints in the test node configuration must be met as a minimum: 
     Potentiostatic: 

Ch 1 (master): Set to Voltage Positive. Disable PID.  Set DC Amplitude = Voc /N 
Ch 2 thru N (slaves):  Set to Voltage Positive. Enable PID.  

Set DC Amplitude = Voc/N 
 

     Galvanostatic: 
Ch 1 (master):  Set to Current Charge.  Set DC Amplitude = 0. 
Ch 2 thru N (slaves):   Set to Voltage Positive. Enable PID. 

 Set DC Amplitude = Voc/N 
 

When building the node diagram, the first node out of the Begin node must be as 
follows: 

Ch 1 (master): Rest Node 
Ch 2 thru N (slaves):  Voltage Positive Node 

This is to insure that the stack can stabilize before entry into active operations by the 
master controller. Exit from the master Rest node should be set to minimum 2 second 
delay. A rest node on master should also exist just prior to exit of the test to allow slave 
channels to shut down gracefully 
Care must be taken to insure that master total path node IDs match all slave channels 
total path node IDs. Node IDs are not shown in the icon. You must double click on the 
icon itself and the node IDs will be shown at the top of the Node Editor. Below is a basic 
example of master channel and slave channel node configurations. Master channel 
Current charge contains a galvanostatic ACZ sweep operation. 

 
Master Channel: 
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Slave Channels: 

 
 
Following loading of the test, one or more of the channels might exceed voltage limits 
and transition into a “Stop with Error”, outlined in red. In order to eliminate this issue, set 
the Shutoff Voltages in the Config tab to -20V for min and +20V for max. This will set the 
limits above the maximum measuring limit of the channel and prevent transition into the 
error state. 
 

Stack-up EIS provides accurate measurement for frequencies at or below 500 Hz. 
Measurements above 500 Hz are adversely affected by the resistor divider network. 
Injection amplitude should typically remain below 1 amp. Injections higher than this 
could affect resistor network causing resistor accuracy drift. It is generally 
recommended to use the lowest injection ampltude possible that still provides a clean 
result with little noise in the plot. 
 
Results: 
Phase plot does not require any adjustment. 
Impedance plot must be multiplied by the number of channels in the serial stack to 
obtain the actual impedance of the battery. This can be done with the Math Tools menu. 
 
 
 



07/31/25  

42 

Keyboard and Mouse Shortcuts 
 

Like any Windows program, you can hold down the Alt key and hit any underlined letter 
to activate that pull-down menu.  Many of the standard Windows Edit Menu control key 
functions also work, for example: 
 
Ctrl+C   Copy Data Set 
Ctrl+V  Paste Data Set 
Ctrl+X   Cut Data Set 
Ctrl+Z   Undo Last Edit 
 
 
The software has keyboard shortcuts associated with it and selecting the parameter 
with the mouse. 
 
Up or Down arrow key  Increments parameters in various parameter editing 

windows according to preset multiplier or integer step 
sizes. 

Page Up or Page Down key Increments parameters in various parameter editing 
windows according to preset integer step sizes. 

 
 
Besides the keyboard shortcuts, there are mouse short cuts. 
 
1) Left click on any point of any data set to select it.   
2) Left click and drag any window or menu to move it or dock it. 
3) Left click and drag the side or corner of a window or menu to resize it. 
4) Use scroll wheel OR right click and drag the graph to the left of the Impedance or 

right of the Phase axes to change the gain or phase scaling respectively. 
5) Left click and drag the graph to the left of the Impedance or right of the Phase axes 

on the Impedance or Phase axes to change the gain or phase range displayed. 
6) Use scroll wheel OR right click and drag the graph anywhere between Gain and 

Phase axis to change frequency scaling. 
7) Left click and drag the graph anywhere between Impedance and Phase axis to 

change range of frequency values displayed. 
8) Use scroll wheel to change modifiable mouse selected parameters according to 

preset step sizes. 
9) A graph that has been manually adjusted, can be reset to the default auto-scaling, 

auto-update mode by clicking on the “A” in the lower left hand corner of the graph 
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Appendix A 
 
 
Direct Computation 
 
The following illustrates an example of implementing a quadratic equation: 
                                              
Given:  y = ( A * x 

2
 )  +  ( B * x )  +  C 

 
  For this demonstration, we assume x is Voltage, 
  And the result ‘y’ is stored in user defined variable “QuadraticResult”. 
 
Create Variables: IntermediateCalculation = Voltage * B + C 
   QuadraticResult = Voltage * Voltage * A + IntermediateCalculation 
 
To insure that the formula is calculated correctly, remember to implement the order of processing 
correctly. Intermediate values must be defined first to be used in subsequent calculations. 

 
 
Conditional Assignment 
 
Let’s assume we want to do the following comparison and assignment as illustrated in pseudo-code 
 
 If Voltage > Vmax then 
  Vmax = Voltage 
 
Voltage is selected for Variable A. Vmax is the new variable. The above comparison can then be rewritten 
as follows for implementation into a conditional assignment: 
  
 Vmax = Voltage > Vmax 
 
 
For a more complex expression such as, 
 
 If  ( ( Voltage > Vmax ) && ( Current  >=  2.5 ) )  then 
  Vmax = Voltage 
 
We can rewrite the function as: 
 
 Vmax = Voltage > Vmax AND Current >= 2.5 
 
Here, the value of Voltage is put into user-defined variable Vmax when the entire string evaluates to 
TRUE.  
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Timed Recursive Log Example 
 
This demonstrates how to define the formulas and logging conditions to perform a log of 
data at 5 second intervals. 
 
 
Create 2 formulas: 

 
  Direct Computation ( Integer ) 
 
     DelayedTime = Time Into Test – 5.0 
 
  Conditional Assignment ( Integer ) 
 
     TriggerTime = ( Time Into Test > 0.0 ) And ( DelayedTime >= TriggerTime ) 
 
 
Create Log Condition for the relevant Log: 
 
     TriggerTime = Time Into Test 
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Appendix B 
 
Calibration Specifications for 21xx, 23xx, 27xx and 29xx ESTi / Nexus instruments 
 
 
THERMAL: 
Adjustment performed at 1ºC, 27ºC and 55ºC ambient 
Calibration (verification) performed at 14ºC and 38ºC ambient 
 
 
OUTPUT DC: 
 
Potential: 18V (1 range only):  +/- 18mV 
Current: All Ranges:   0.2% of FSR 
 
OUTPUT AC: (on equipped models) 
 
Potential: 18V (1 range only):  0.5% of FSR 
Current: 5A, 150mA and 5mA Range: 0.2% of FSR  
 150µA and 5µA Range:  0.5% of FSR 
 
 
MEASUREMENT, DC and AC: 
 
Potential: 18VRange:  0.2% of FSR 
 1.8V Range:  0.26% of FSR 
 180mV Range:  0.4% of FSR 
 18mV Range:  1.0% of FSR 
 
Current: All Ranges:  0.2% of FSR 
 
Auxiliary: 20V and 2V Ranges  0.2% of FSR 
 
AC Measurement Note: 
Measurements are calibrated in real time at the sampling layer (each individual sample). 
As a result, only calibration to DC standards is required and provides more accurate 
results for AC measurements.  
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 AC Impedance Accuracy Contour Plot: 
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Appendix C 
 
Hardware Description of ESTi instruments 

 
2161, 2165, 2185, 2361, 2365, 2385 Front Panel 
 
 

 
 
 
Description 
 

1. Status OK:  This green LED Illuminates when the power is turned on and the device  
  has completed boot up operation. 
2. Enabled: This yellow LED Illuminates the output is active. 
3. Auxiliary Jack: Provides for additional voltage measurement connection, or for supported 

  digital sensors. 
4. Main Jack: Provides signal connection for the Working and Counter Electrode contacts 

 and the electrometer reference contacts. 
5. Power Switch: This switch turns the instrument on and off. 
6. Button: Not implemented. 
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2161, 2165, 2185, 2361, 2365, 2385 Rear Panel 
 
 

 
 
 
 
Description 
 

1. Power Inlet: Supplies the required 90 to 264Vac, 48 to 62Hz, and 150VA power to 
 the instrument. 

2. Fuse: Fuse holder for 3A/250V slow-blow fuse. 
3. Ethernet Port: Provides Ethernet communication with the Venable ESTiView software. 
4. Cooling Fans NOTE: Do not block airflow. 
5. Ground Plug When installed, this connects the instrument to earth ground. The plug can 

 be removed to connect the instrument to a floating reference. 
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Hardware Description of Nexus instruments 
 
Front Panel 
 

 
 
Description 
 

1. Status OK:  This green LED Illuminates when the power is turned on and the device 
  has completed boot up operation. 
2. Enabled: This yellow LED Illuminates the output is active. 
3. Auxiliary Jack: Provides for additional voltage measurement connection, or for supported 

  digital sensors. 
4. Main Jack: Provides signal connection for the Working and Counter Electrode contacts 

 and the electrometer reference contacts. 
5. Power Switch: This switch turns the instrument on and off. 
6. Button: Not implemented. 

 
 
 
 



07/31/25  

50 

Nexus Rear Panel 
 

 
 
Description 
 

1. Power Inlet: Supplies the required 90 to 264Vac, 48 to 62Hz, and 1500VA power to 
 the instrument. 

2. Fuse: Fuse holder for 12.5A/120V or 6.3A/250V slow-blow fuse. 
3. Ethernet Port: Provides Ethernet communication with the Venable ESTiView software  
4. Cooling Fans NOTE: Do not block airflow. 
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